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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

Caution

Indicates procedures which may result in damage or injury if sufficient care is not taken.

Indicates additional information and points which may be useful to know regarding a topic.

Timer (Boldface)

- Indicates a page where detailed information regarding a topic can be found.
Procedure Indicates operating methods and the order of operations.
The procedure indicated should be carried out in the order of the numbered steps.
[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.
Example: Esc button
"(Name)" Indicates the name of the buttons on the EasyMP Monitor or OS screens.

Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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EasyMP Monitor Features
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Tasks that can be done using EasyMP Monitor

Tasks that can be done using EasyMP Monitor

EasyMP Monitor lets you carry out operations such as checking the
statuses of multiple EPSON projectors that are connected to a network at
a computer monitor, and controlling the projectors from the computer.

Following are brief descriptions of the monitoring and control functions
that can be carried out using EasyMP Monitor.

¢ Registering projectors for monitoring and control

Projectors on the network can be searched for automatically, and you
can then select projectors to be registered from the projectors that are
detected.

You can enter the IP addresses for target projectors to register them.

¢ Registered projectors can also be assigned to groups so that they can
be monitored and controlled in groups.

® Monitoring the statuses of registered projectors

The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.

You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or the
details of information such as input sources, problems, and warnings
for these projectors.

e Controlling registered projectors

Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.

Web control functions can be used to change the settings in the
projector's configuration menu.

If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use Timer Settings to
register timer settings.

e Mail notification function settings

You can set e-mail addresses to which notifications are sent if a status
requiring attention, such as a problem, occurs with a projector that has
been registered.

il

:@:- To enable projectors to be monitored and controlled even when they are in

standby mode’, make the following settings at the projectors. The settings
that need to be made will vary depending on the projector you are using.
@ Projector's User's Guide

e Set Standby Mode to Communication On (or Network On).
e Set Network Monitoring to On.

* When the projector's O indicator is lit orange.
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Installing EasyMP Monitor

Installing EasyMP Monitor

Operating environment

This software is compatible with computers that comply with the
following requirements.

e Operations carried out at the computer may become slow depending
on the number of projectors being managed. If this happens, use a
computer with higher specifications.

e EasyMP Monitor cannot be used in environments which do not allow
pings to be transmitted.

(0} Windows 98 Second Edition SP1
Windows Me

Windows NT4.0 SP6

Windows 2000 Professional SP4

The following 32-bit operating systems:
Windows XP Home Edition SP2/SP3
Windows XP Professional SP2/SP3

Windows Vista
(All editions except Starter Edition)

Windows Vista SP1/SP2
(All editions except Starter Edition)

Windows 7
(All editions except Starter Edition)

Internet Explorer Ver. 5.0 or later must be installed.

Supported language

EasyMP Monitor supports the following languages.

HZA:E, English, Frangais, Deutsch, Italiano, Espariol, Catala,
Portugués, St=01, X (&), F 3 (84K, Nederlands, Dansk, Polski,
Magyar, Cesky, Romana, Slovens&ina, Norsk, Svenska, Suomi,
Pycckuid, YkpaiHcbka ™1, EAAnvikd, Tirkge, dw,edi*2 , aen'lng,
Bahasa Indonesia, Hrvatski, Slovencina, Bbnrapcku esvk, s> (ile,
tiéng Viét, nnay*2

*1 Ifyour OS is Windows Vista, you must update to Windows Vista SP1 to use
the Ukrainian version of EasyMP Monitor.

*2 Windows NT4.0 does not support Arabic and Hebrew versions.

CPU Pentium MMX 166 MHz or higher (Pentium Il 233 MHz
or higher recommended)

Memory 64 MB or more (128 MB or more recommended)

capacity

Free hard disk 50 MB or more

space

Display SVGA (800 x 600) or higher resolution, 32 bit or higher
display color

e Macintosh computers cannot be used.

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the
projector settings to this version. The settings are stored as a data file
(EMP Monitor.dat). Make a copy of the EMP Monitor.dat before you
install this software. EMP Monitor.dat can be found at the following
location if the default settings were used to install the software:
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Installing EasyMP Monitor

e If your operating system is Windows 98, Windows Me, Windows 2000,
Windows NT4.0, or Windows XP

"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver.
x.xx (Ver. x.xx represents the software version)"

e If your operating system is Windows Vista or Windows 7
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector\EasyMP (or EMP) Monitor Ver. x.xx (Ver. x.xx
represents the software version)"

If you cannot find the "AppData" folder, click "Start" - "Control Panel"
- "Appearance and Personalization” - "Folder Options". Select "View"
tab, and then configure the "Show hidden files, folders, and drives"
setting in "Advanced settings".

After installing this software, follow the instructions below before

starting EasyMP Monitor to transfer the settings.

e If your operating system is Windows 98, Windows Me, Windows 2000,
Windows NT4.0, or Windows XP

Overwrite the existing EMP Monitor.dat file with the copy you made.
The existing EMP Monitor.dat file is in "C:\Program Files\EPSON
Projector\EasyMP Monitor Ver.4.40".

e If your operating system is Windows Vista or Windows 7

Place the copy of the EMP Monitor.dat file in "C:\Users\(User
Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP Monitor Ver.4.40".

- The software name has been changed.
Before: EMP Monitor — After: EasyMP Monitor

If you are already using EMP Monitor, you can replace it with this software.

Installing

When you are using the following OS, you must have administrator
authority in order to install EasyMP Monitor.

e Windows NT4.0
e Windows 7

e Windows 2000 e Windows XP

e Windows Vista

If EasyMP or EMP Monitor is already installed, uninstall it before
installing this software. @ p.46

When your OS language is supported by EasyMP Monitor, the software
is installed in the same language as your OS automatically.

However, the following cases are exceptions.

e When using Windows NT4.0: Since Arabic and Hebrew are not
supported, English is selected for the installation.

e When using Windows Vista: You must update to Windows Vista SP1
to use the Ukrainian version.

When the language selected for the EasyMP Monitor installation varies
from that of the OS being used, the screens may not be displayed
correctly.

Procedure

) Turn the computer on.

To prevent problems from occurring during the installation, we
recommend that you terminate all resident applications that can be
ended.

° ) Load the supplied Projector Software CD-ROM in your
computer.

The installer automatically starts up.
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Installing EasyMP Monitor

@ From here, continue with the installation by following the
on-screen messages.

Limitations imposed by a Windows Vista or
Windows 7 environment

When using EasyMP Monitor under Windows Vista or Windows 7, note
the following limitations.

® You must have administrator authority in order to use Register at
startup on the Environment setup screen of EasyMP Monitor. @ p.27

e If EasyMP Monitor is installed on your computer, uninstall it before
you update the operating system to Windows Vista or Windows 7.
Updating your OS without uninstalling the software may cause a
malfunction. @ p.46

Before starting operations

Check the following points before starting up EasyMP Monitor.

e EasyMP Monitor must be installed on the computer to be used for
monitoring and control.

e The computer and the projectors must be connected to the network.

o If using Windows 2000/Windows NT4.0/Windows XP/Windows
Vista/Windows 7, the computer must be started up in Administrator
mode.

¢ Depending on the projector model, a commercially-available serial «»
TCP/IP conversion adapter and a connection cable are required in
order to use EasyMP Monitor. @ Projector's User's Guide

Make the settings for the serial «» TCP/IP conversion adapter before
connecting to the projector.
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Registering and deleting projectors for monitoring

gww-wm,,,%
Registering and deleting projectors for monitoring g@g The main window will be displayed.
This operation is carried out when starting EasyMP Monitor for the first The red box area described in the screen below is referred to as

time after it has been installed and when you would like to add

projectors. Once a projector has been registered, the status for the
projector will be displayed automatically each time EasyMP Monitor is & _OX
started from that point onwards. ;

Grouping view.

B¢ B R HE =R E ==Y

Select all

The operations to register projectors vary as followings depending on
where the projectors are connected to in the network.

e When registering a projector that is located in the same segment as the
computer in which EasyMP Monitor is installed. @ "Registering
projectors using automatic search (Searching for and registering
projectors that are located in the same segment)" p.12

e When registering projectors that are in multiple segments of the
network. @ "Setting the range of addresses to do an automatic search
and registration" p.14

Starting EasyMP Monitor

Procedure

@ Click "Start" - "Programs" (or "All Programs") - "EPSON
Projector" - "EasyMP Monitor Ver.4.40" in that order to start
EasyMP Monitor.
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Registering and deleting projectors for monitoring

. . . . . : ; Click "Search".
Registering projectors using automatic search @

(Searching for and registering projectors that are
located in the same segment)

Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.

If a projector does not appear in the list, use "Registration by spec-
ifying an IP address (Manual registration)". @ p.17

Procedures for automatic search

Create new projector (automatic registration)

Projector name IP address

Procedure Projector10 192.168.040
Projectar1l 192168041

Projector1? 192168042

Right-click in Grouping view and select "New" - "Projector Projector!3 192168043

. Projector1d 192168044

(automatic search)". Projectorl5 192168045
Projector1B 192168.046

The following Create new projector (automatic registration) win-
dow will be displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

[ Specify an address range and search.

Start address End address

Create new projector {automatic registration) Search Edit Canicel

:@:‘ e You can also carry out this operation by selecting New - Projector
! (automatic search) from the Edit menu.

e Projectors that are using a serial «» TCP/IP conversion adapter cannot be
detected.

[ Specify an address range and search,

Skart address End address

Search Edit Cancel
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Registering and deleting projectors for monitoring

Procedures for registration

Procedure

) Select the projector(s) to be registered from the displayed
list, and then click "Edit".

The following window will be displayed.

Create new projector {automatic search)
Display name | |
Dizplay ican
< | 2
Parent group | [Mone] j
Projectar hame | Projector10
IP address | 169 . 254 . 183 . 181 Search
-
Part Murnber ’7
td onitor Pazsword |
Description
v Moritar
Register Cancel

Make the necessary settings while referring to the following table.

Display name

Enter the name of the projector(s) to be
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group

Select when registering a projector in a group.

If no groups have been created, this cannot be
selected. @ "Registering several projectors to a
monitoring group all at once" p.18

Projector This shows the name that has been registered on
name the projector.
IP address This shows the IP address for the registered

projector.

Use Serial «
TCP/IP
conversion
adaptor.

This cannot be selected when registering
projectors using automatic search.

Port Number

This cannot be selected when registering
projectors using automatic search.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered.

Description

You can enter some kind of memo about the
projector. The details you enter here will be
displayed at the projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.
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Registering and deleting projectors for monitoring

§.» g«»\“’“\“"””%%
\£/ After entering the details, click "Register" to start the @@ Select the "Specify an address range and search." check box
registration. When the message is displayed, click "OK". and then enter "Start address" and "End address" in the
range.

To continue registering other projector(s), repeat Steps 1 and 2.

Create new projector (aukomatic registration)

—:@- Projectors that have been registered using automatic search are searched
’ for again by projector name each time EasyMP Monitor is started.

) To end the registration operation, click |E| in the top-right
corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout” p.21 for details on using
the Grouping view and Detail list view.

Iv Epecify an address range and search.

Start address ( 192 , 166 . 0 . 00 )nd address ( 192 , 168 . 0 . 50 "
A

Search i Edit Cancel

Setting the range of addresses to do an automatic
search and registration

4
;@- Projectors that are using a serial «» TCP/IP conversion adapter cannot be
’ detected.

Procedures for automatic search

Procedure

oy,

Right-click in Grouping view and select "New" - "Projector
(automatic search)".

The Create new projector (automatic registration) window will be
displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.
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Registering and deleting projectors for monitoring

Click "Search".

Automatic searching will be carried out, and the names of the pro-
jectors that have been detected will be displayed.

Projector name IF address
Projector10 192168040
Projectar1l 192168.041
Projector12 192168042
Projector13 192168043
Projector14 192168044
Projectorls 192168045
Projector1d 192168046

I¥ Specify an address range and search,

Start address 192 . 168 .0 . 00 End address 192 . 168 . 0 . 50

Search H Edit Cancel
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Registering and deleting projectors for monitoring

Procedures for registration

Procedure

) Select the projector(s) to be registerd from the displayed list,
and then click "Edit".

The following window will be displayed.

Create new projector {automatic search)
Dizplay name | |
Digplay icon
2 e o
| | o
Parent group | [Mone] j
Projector name | Projector10
IP address [ 169 . 284 163 . 1m0 Search
r
Part Murnber ’7
M anitar Pazsward |
Description
v Monitor
Renqister Cancel

Make the necessary settings while referring to the following table.
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Display name

Enter the name of the projector(s) to be
displayed in Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group

Select when registering a projector in a group.

If no groups have been created, this cannot be
selected. @ "Registering several projectors to a
monitoring group all at once" p.18

Projector This shows the name that has been registered on
name the projector.
IP address This shows the IP address for the registered

projector.

Use Serial «
TCP/IP
conversion
adaptor.

This cannot be selected when registering
projectors using automatic search.

Port Number

This cannot be selected when registering
projectors using automatic search.

Monitor
Password

If a Monitor Password has been set for the
projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered.

Description

You can enter some kind of memo about the
projector. The details you enter here will be
displayed at the projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.




Registering and deleting projectors for monitoring

@ After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

Registration by specifying an IP address (Manual

To continue registering other projector(s), repeat Steps 1 and 2. regls"atlon)
To end the registration operation, click E in the top-right Procedure
corner of the window or click "Cancel". /

' Right-click in Grouping view and select "New" - "Projector

The icon(s) of the projector(s) you registered will be displayed in A (manual registration)".

Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.21 for details on using The following window will be displayed.

the Grouping view and Detail list view. If Detail list view is displayed, select New - Projector (manual reg-
istration) from the Edit menu.

Create new projector {manual registration)

Display name [l
Display icon
@ o
< | -
Barert group | Mane) Rd
Projgctor name |
IF address | . . . Search

[ Use Serial <-» TCPAP conversion adaptor.

Port Mumber

tdomitor Password |

Degcription

[V Manitor

Register Cancel

Download from Www.Somanuals.com. All Manuals Search And Download.



Registering and deleting projectors for monitoring

,@1 You can also carry out this operation by selecting New - Projector (manual

registration) from the Edit menu.

Enter the IP address of the projector to be registered in the

"IP address" box and then click "Search". When the message
is displayed, click "OK".
If using a serial «» TCP/IP conversion adapter and cable to connect

the projector, select Use Serial «» TCP/IP conversion adaptor.,
enter the port number in Port Number, and then click Search.

After searching is complete, enter the information for the
projector to be registered while referring to the table below.

Display name

Enter the name of the projector(s) to be displayed
in Grouping view or Detail list view. Up to a
maximum of 32 bytes can be entered. A space
cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in Grouping
view or Detail list view.

Parent group

Select when registering a projector in a group. If
no groups have been created, this cannot be
selected.

@ "Registering several projectors to a
monitoring group all at once" p.18

Projector This shows the name that has been registered on
name the projector.
IP address This shows the IP address that you entered in

step 2.

Use Serial «
TCP/IP
conversion
adaptor.

Select this if using a serial «» TCP/IP conversion
adapter to connect the projector.

Port Number | If using a serial «» TCP/IP conversion adapter to
connect the projector, enter the port number.

Monitor If a Monitor Password has been set for the
Password projector, be sure to enter the Monitor Password
that has been set. If the correct password is not
entered at this time, it will not be possible to
monitor and control the projector even though it
is registered. If using a serial «» TCP/IP conversion
adapter to connect the projector, the Monitor
Password security function cannot be used.

Description You can enter some kind of memo about the
projector. The details you enter here will be
displayed at the projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

) After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Registering several projectors to a monitoring group
all at once

Projectors that have been registered can then be registered together into
different groups so that they can be monitored and controlled together.

Furthermore, if you select one of the registered groups as the Parent
group, monitoring and control operations can be carried out for all
projectors in that Parent group.

A Parent group can be set for other parent groups, so that a hierarchical
group arrangement can be created.
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Registering and deleting projectors for monitoring

First, create the registration groups, and then register projectors into the
groups that have been created.

Procedure

' Right-click in Grouping view and select "New" - "Group".
The following window will be displayed.

Make the necessary settings while referring to the table below.

-

If Detail list view is displayed, select New - Group from the Edit
menu.

o

Cancel

Group name Enter the name of the group to be displayed in

Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A
space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping

view or Detail list view.

Parent group | This selects the parent group. If no groups have

been created, this cannot be selected.
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Monitor Select this to monitor all projectors that have
been registered in the group. If this is not
selected, the settings made when the individual

projectors were registered will be used.
It cannot be set when creating a new group.

You can also carry out this operation by selecting New - Group from the
Edit menu.

§ When the setup is complete, click "Register" to start the

registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Right-click the projector icon(s) to register to the group you

have created in Grouping view or Detail list view, and select
"Edit".

You can also carry out this operation by selecting Edit in the Edit menu.

$ In the Edit projector window, select the group name to use

for registering in Parent group and then click "Change".

The status of the group registration will be displayed as an icon in
Grouping view or Detail list view.

The registration details can also be checked using Projector list in the View
menu.
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Registering and deleting projectors for monitoring

If the projector name or IP address changes after
registration

For projectors that have been registered manually

Procedure

Right-click on a projector icon in Grouping view or Detail list
view and select "Monitoring disabled". Then right-click the
projector icon again and select "Edit".

‘@:— You can also carry out these operations by using the Edit menu.

| If only the projector name has been changed, click "Search"
in the Edit projector window that is displayed. If the IP
address has been changed, enter the new IP address in the
"IP address" box and then click "Search". When the message
is displayed, click "OK".

) When the display returns to the Edit projector window, click
"Change".

For projectors that have been registered using automatic
search

Procedure

) Delete the projector(s) whose name or IP address has been
changed in Grouping view or Detail list view. @ p.20

M Carry out automatic search to re-register the projector(s).
@ p.12

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer
required for monitoring or control using EasyMP Monitor.

Procedure

Right-click the icon for the projector or group that is to be deleted
in Grouping view or Detail list view and select "Delete". When the
message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in
Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as
follows.

e If you select a Group icon in Grouping view, all projectors that have
been registered in that group will be deleted at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

¢ Use drag and drop to select a range of desired icons.

Az

@:— You can also carry out this operation by selecting Delete in the Edit menu.
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Monitoring window layout

Monitoring window layout o Detail list view
This view lets you display the status of each projector as a list so that the
projectors can be checked in detail. You can also display specific items

Types of monitoring windows and switching method as a list, and sort display items using a specific row as a sort key.

s

2
i

5
(<]
c

188

)

Fla
&

L&
]
4]
]
[
®
8
4

Types of monitoring windows
There are two types of monitoring windows. Select a desired window.
¢ Grouping view
This view lets you check the status of group registrations in a
hierarchical diagram.

©0000000009000 o

 GEEHEPEREEBEEE|;

Detail list view

&
e oo FE-TBBAB=wEaTK
How to switch views
K O w o s .
=T Grouping view and Detail list view are switched as follows.
s 8
w s e |

Grouping view
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Procedure

Click the View menu, and select "Grouping view" or "Detail list
view".

Monitoring using Grouping view

Meanings of Grouping view icons

In Grouping view, the patterns on the icons indicate the statuses of the

projectors. If the group icons are round in shape, it indicates that there is
another level below them. @ p.23

— T

jle  Edit  Wew Tool  Help
Refiesh | Selectal

@i
©

Shoviroarn & Showroom B
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Monitoring window layout

The icon patterns and their meanings are explained below.

No warnings or problems

All projectors in the group are normal.

Warning or problem

A projector in the group has a warning or problem status.

Notification

A projector requiring immediate attention has been detected
within the group.

Monitoring disabled

The projector is not being monitored. If you right-click the icon and
select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

L{& Data being updated
Projector
wa |Nowarningsor problems’’
Ve Warning or problem
@ Notification
. Monitoring disabled
g |Databeing updated
<) |Network error (Monitor Password authentication error)
&l No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered. @ p.13,
p.16, p.17
@ Network error (TCP connection error)

Projector

@ Network error (ESC/VP.net communication error) >
{ P

-,

*1 When Temperature level display group view is set to On at Environment
setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Off. As you can get an idea of how the temperature inside the projector is
increasing when Temperature level is displayed, you can make
improvements to the projector's operating environment before a high
internal temperature error or high-temperature warning occur. @ p.28

*2  Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.

:@3 The projector information that is generated when a problem is detected is

’ stored until EasyMP Monitor is closed. EasyMP Monitor displays will not
be updated automatically even if the projector status returns to normal.
Click "Refresh" in the main window to update the status.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.

¢ Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector
that have been registered in that group are displayed or hidden.

¢ Moving icons
To change the position of an icon within Grouping view, simply drag
and drop the icon to be moved.
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Monitoring using Detail list view

Meanings of Detail list view icons

The status of registered projectors is displayed as a list in Detail list view
regardless of which Group the projectors belong to.

[ (N I U I — O

OO BE-FEREEEH = E S T

7

isplay name aner amg Hours emperature evel o nfarmation
cbby (@) 3H EEE=|

Eranch A/Convention — (@) 1204 | —

Branch A/Cor — (@) 60H | —

Branch A/Shawrsom/Showrsom | @ 18H | |

Branch &/Shawrsom/Showrsom a | ho2 (@) ™ ||

Branch A/Shawrsom/Showrsom | 7] (@) asH | |

Brarch A/Showrsom/Showrsom 8 | hos (@) 204 | |

Branch AShowrsom/Showrsom B | Hos (@) En | |

Branch B/Conference Roam o @ 49H | m—

Branch B/Conference Room o @ 100H | m—

Branch B/Conference Room 02 @ H | m—

Branch B /Confersrce Fioom [ (@) 78H EEE=|

Biranch B fFieception Floom 0om 1 (@) 79H | — i

Branch B /Receplion oom 0om 2 @ B0H | ——| [
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The icon patterns and their meanings are explained below.

1 Type
Displays the projector status.
No warnings or problems '

Warning or problem

& €

An error has occurred on the projector.

Notification

The projector requires immediate attention.

Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to
the projectors that are being monitored.

Data being updated
Network error (Monitor Password authentication error)

@l

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered.
@ p.13,p.16, p.17

@ Network error (TCP connection error
@ Network error (ESC/VP.net communication error

)2
)3
2 Group name

When projectors are registered to a group, the name of the group that
the projector belongs to is displayed.

3 Display name
Shows the display name.
4 Power
Shows the power on status for the projector.
@ Poweronandnormalstatus @) Power off and normal status

@\ Power on and abnormal @) Power off and abnormal
status status

5 Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.
Temperature level

The following five icons display the differing internal temperature
status of the projector.

""" Internal temperature == |nternal temperature

normal normal

[EEE 1 High-temperature E==E | High-temperature
warning warning

Internal temperature
error

Error information

Shows a notification or warning/problem status using the following
icons.

Clean Air Filter Notice Replace Lamp 4

"

Replace Lamp (Lamp 1) Replace Lamp (Lamp 2)

Lamp error (Lamp 1) Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)

Lamp failure at power on
(Lamp 1)

High-temperature warning Replace Air Filter

=1 No Air Filter

B Sed

Low Air Flow

Supply System Error
(Ballast 1)

Cinema filter warning

Air Flow Sensor Err.

111
11

3 SHhild SYesw

2

Supply System Error
(Ballast 2)

Shutter warning Lamp Cover Open

Lamp Error (Lamp 1)

“

Lamp Error

e m

Lamp Error (Lamp 2) Lamp failure at power on

B
ap)
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*1

*2

Lamp failure at power on

[E Lamp failure at power on
(Lamp 2)

(Lamp 1)
Low air flow error

E =

High internal temperature
error

Air filter air flow sensor error [@j Internal Error

=

nn
1

-4 |

Fan error Sensor error

BE

Supply System Error

2l
(=P

Supply System Error

(Ballast) (Ballast 1)
Supply System Error @ Auto Iris Error
(Ballast 2)

Cinema filter error Shutter error

Cooling system error
(pump)

DE &
7323

Cooling system error
(Peltier element)

Other error

When Temperature level display group view is set to On at Environment
setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Oft.

Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

Check that the projector has been correctly connected to the network.

You can display Replace Lamp at any time preset at Environment setup in
the Tool menu.

o The projector information that is generated when a problem is detected is
stored until EasyMP Monitor is closed. EasyMP Monitor displays will not
be updated automatically even if the projector status returns to normal.
Click "Refresh" in the main window to update the status.

e Detectable error information differs depending on the projector you are

using.

Selecting display items

You can select only the required items to be displayed in Detail list view.

Procedure

The Option window will be displayed.

Option

Dizplay items

v Group name

[ Projector name
v Dizplay narme

[ IP address

¥ Power

v Lamp Hours

[ Source

¥ Temperature level
[ Description

Iw* Error information

ok

s,

i@g Select the check box of the item you want to display.

&) click"ok".
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Monitoring window layout

W: When all of the details of the item cannot be displayed in Procedure
Detail list view, drag the boundary line on the right of the
item name so that the view is extended to the desired width. Select "Projector list" from the View menu.

The following window will be displayed.
Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as 7 (&) Convertion Hal

projector name order or IP address order. @ Lobby
= Shawraom
- Showroom A
Procedure 4| Not
@& Noz2
@ Mol

Click the item name of the row you want to use as the sort key. @ . @héhﬂwmmB
+ ] oranc
Branch C

Searching for desired icons (Projector list)

With Projector list, temperature level icons are not displayed regardless
of the setting of Temperature level display group view at Environment
setup.

The Projector list feature is useful for searching in lists when many
groups and projectors are registered and the icon you are looking for is

t displayed .
1ot dispiayed ofi screen The Projector list lets you check the registration details for groups in a

hierarchical diagram. When you click on an icon, Grouping view and
Detail list view are scrolled so that the selected icon is displayed in the
window.

Monitoring using the system tray
The projector statuses are always displayed as icons in the system tray,

even when Grouping view or Detail list view is not always displayed, and
the statuses can be checked by the icon patterns.
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When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

The icon patterns are explained below.

© Noproblem /Ay Problem

Procedure

Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

' Select "Resident in the task tray".

Environment setup

Update interval I H minutes

Temperature level display group view & Off (ol

Lamp schedule notification = 0 £ 0n 1000 3; Hour
Lag output ~ DI £ On

™ Register at startup

™ Change the application lock password

Old password I

New password I

New password [confiim] I

0K Cancel

72\
@s Click "OK".

\
:@: e Right-click the icon in the system tray to open a pop-up menu to select the
! Open the main screen or Exit.

o If Register at startup in the Environment setup is selected, EasyMP
Monitor starts automatically when the computer's power is turned on.
When using EasyMP Monitor under Windows Vista or Windows 7, you
must have administrator authority in order to use this function.

Displaying projectors with problem or warning
statuses in a list

You can display a list of only the projectors which have a problem or
warning status.

Procedure

Select "Warning and Error Projector list" from the View menu.

The following Warning and Error Projector list window will be
displayed.
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If you move the mouse pointer over the icon of the Error information,
details of the error and the remedy will be displayed. If you double-click
in a line, the properties for that projector will be displayed. @ p.32

5 lect all

]

Display narm
ProjectorDl

No3

Power]

@
@

Lamp Hours

120H

85H

Temperature level

[T
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The icon patterns and their meanings are explained below.

1 Type
Shows the group or projector status.
No warnings or problems '

Warning or problem

& €

An error has occurred on the projector.
Notification

The projector requires immediate attention.

Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to
the projectors that are being monitored.

Data being updated
Network error (Monitor Password authentication error)

IS

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered.
@ p.13,p.16, p.17
@ Network error (TCP connection error)*2
@ Network error (ESC/VP.net communication error) >
2 Display name
Shows the display name.
3 Power
Shows the power on status for the projector.
@ Poweronandnormalstatus @) Power offand normal status

@\ Power on and abnormal @) Power off and abnormal
status status

4 Lamp Hours
Shows the lamp operating time for the projector.

5 Source

Shows the input source that has been selected for the projector.

A @@ Computer or B @ Computer2
Qo= Computerl Q0L=2

000 BNC 5 S-Video

I? Video (BNC)

Video (RCA)

DVI-D1 or HDMIT,
DVI-D, HDMI™

E=) D-Video (T;\Sf-—y_ﬂ:‘ EasyMP
-] USB Display gCagy| USB or USB1
RS UsB2 g/ | LAN

6 Temperature level

The following five icons display the differing internal temperature
status of the projector.

= Internal temperature == |nternal temperature

normal normal

EEE ] High-temperature [E=== | High-temperature
warning warning

Internal temperature
error

Error information
Shows a warning/problem status using the following icons.
ﬁ Replace Lamp © a’-l Replace Lamp (Lamp 1)

f8 Replace Lamp (Lamp 2) g Lamp error (Lamp 1)

Download from Www.Somanuals.com. All Manuals Search And Download.



Monitoring window layout

P
&

18 SEE

“

=

F 20 =

2L

2

Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)

Replace Air Filter
Low Air Flow

Supply System Error
(Ballast 1)

Cinema filter warning
Lamp Cover Open

Lamp Error (Lamp 1)
Lamp failure at power on

Lamp failure at power on
(Lamp 2)

Low air flow error
Internal Error

Sensor error

Supply System Error
(Ballast 1)

Auto Iris Error
Shutter error

Cooling system error
(pump)

5 X

E EYEd

1
1

&
23 il

(=]

B

=

Lamp failure at power on
(Lamp 1)

High-temperature warning

No Air Filter
Air Flow Sensor Err.

Supply System Error
(Ballast 2)

Shutter warning
Lamp Error
Lamp Error (Lamp 2)

Lamp failure at power on
(Lamp 1)

High internal temperature
error

Air filter air flow sensor error
Fan error

Supply System Error
(Ballast)

Supply System Error
(Ballast 2)

Cinema filter error

Cooling system error
(Peltier element)

Other error

*1 When Temperature level display group view is set to On at Environment
setup in the Tool menu, an icon indicating the internal temperature of the
projector will be displayed on top of the projector icon. The default setting
is Off.

*2  Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On)
or Network Monitoring is set to On in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.

*4 Ttdescribes DVI-D if the projector is equipped with both DVI-D and HDMI
input terminal.

*5 Itdescribes HDMI if the projector is equipped with both DVI-D and HDMI
input terminal.

*6 You can display Replace Lamp at any time preset at Environment setup in
the Tool menu.

Detectable error information differs with the projector you are using.

Checking properties in detail

You can check the properties of Group and projectors in detail.

Displaying Group properties
Procedure

You can use either of the following methods to display the proper-

ties.

¢ Displaying the properties for all groups in Grouping view
Right-click in Grouping view and select Property.
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e Displaying the specified group properties Displaying Projector properties
Right-click an icon in Grouping view and then select Property.
Right-click on a projector icon in Grouping view or Detail list view and

. select Property.
Refresh Select al (I) (b Eg ooa @ @ @ &%_ B | e g
Type | Display name | Power | Lamp Hours Source | Temperature level | Ermor information
A s = B nfomlion,Tiver
@ CorwentionHe  — —_ -
@ Labby @ = m Group hame Branch &
Projector name testl
Dizplay name Lobby
IP address 1012.0.224
Lamp Hours 33H
Temperature level T
J ﬂ Drescription
| Serial Murnber 20000 |}
: . . : . “Wersion informati F1 64001 330571 5%/030
If you double-click in a line, the properties for that group or projector sen riamaton F2 A0S0
F3 E141WWAwE100
WIll be dlsplayed' Enion information Mo signal

1 Shows the projector's serial number. If hyphens are displayed, confirm
the serial number on the label of the projector.

2 Displays the projector firmware version.

Displaying and deleting logs

In your web browser, you can check a transmission log of content, such
as what has been controlled by EasyMP Monitor, and projector errors.
You can delete logs once you have checked them.
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A /.
E@: When Log output is set to On at Environment setup in the Tool menu,
’ transmission logs are stored. The default setting is Off.
Displaying Log
Procedure

Select "Log" - "View" from the View menu.

The web browser will open and the communication logs up until that
time will be displayed.

Deleting Log

Procedure

Select "Log" - "Delete" from the View menu. When the confirma-
tion message is displayed, click "OK".

Alllogs will be deleted and details of EasyMP Monitor control operations
and details of projector errors from that point onward will be recorded in
a new log.
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Using the control functions

Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail
list view, and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more
than one projector in Grouping view or Detail list view and clicking a
control button. The methods of selecting more than one projector at the
same time are as follow.

o If you select a group icon in Grouping view, all projectors that have been
registered in that group and that are set to be monitored can be
controlled at the same time.

¢ Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

¢ Use drag and drop to select a range of desired icons.

File  Edt Yew Tool Help
C Reesh | sekctal 7Y (ﬂ)d) Eﬁm@u%ﬁ%“@

Branch B Branch C
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The following table lists the control button functions.

o) Power On Turns the projector power on.
& Power Off Turns the projector power off.
= Switch source Switches the video input source to the
ok Computer1 Computer1 port or Computer port.
Switch source Switches the video input source to the
m
oo Computer 2 Computer2 port.
Switch source Switches the video input source to the BNC
- BNC port.
Switch source Switches the video input source to the
=g S-Video S-Video port.
= Switch source Switches the video input source to the Video
Video (RCA) port or video2 port.
= Switch source Switches the video input source to the Video1
Video (BNC) port.
— Switch source Switches the video input source to the DVI-D1
=1 DVI-D, HDMI 1 port or HDMI1 port.
If the projector is equipped with ether DVI-D
port or HDMI port, use this button to switch
the input signal.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
DVI-D as an input source.
Switch source Switches the video input source to the DVI-D2
=2 DVI-D, HDMI 2 port or HDMI2 port.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
HDMI as an input source.
Switch source Switches the video input source to the D4
D-Video port.

Switch source Switches the input source to EasyMP or

EasyMP EasyMP.net.

Switch source Switches the input source to USB Display.
= . *
= USB Display

Switch source Switches the video input source to the
a1 USB1" external equipment connected via a USB

(Type A) port or USBT.

Switch source Switches the video input source to the

- USsB2" external equipment connected via a USB2

port.

Switch source

o Switches the video input source to the image
YA | LAN

projected by the computer via a network.

* If the button does not function, you can switch the input source using the

button.

:@:- e Some connected projectors may not be equipped with all of the above ports
! or functions. If you click a button for a port or function that is not
available, nothing will happen.

e You can select objects to be controlled and use the control buttons to carry
out control operations even when the following are being displayed.

Group properties @ p.31
Projector properties @ p.32

Warning and Error Projector list
(Control operations can only be carried out for projectors with a warning
status.) @ p.28
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Carrying out control using a web browser (Web
control)

You can use the computer's web browser to change the configuration
menu settings for projectors.

Procedure

Right-click on the icon of a projector to be controlled in
Grouping view or Detail list view and select "Web control".

) The web browser will open and the Web control window will
be displayed.

Web control lets you set the same details as the configuration menu for
the projector. @ Projector's User's Guide

Az

:@:‘ You can select projectors and right-click on them to select Web control
’ even when the following are being displayed.
Group properties @ p.31

Warning and Error Projector list (Control operations can only be carried
out for projectors with a warning status.) @ p.28

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning

a projector's power on and off at specified times every day or every week.

Timer settings can be carried out either for a single projector only, or all
at once for all projectors in a group.

Procedure

Select "Timer" - "Timer Settings" from the Tool menu.

The following window will be displayed and you can then check the timer

setting status.

- N

‘T_EEIQE-@

Projectors Date
= E eranch A 4 04/2009 4
= Cl tion Hall
i SUN | MON | TUE | weD [ THU [ PRl [ SAT
= Bl showroam | ,,,,,, | 1 2 3 4
= £, Showroom A 5 6 7 ¢ 8 E 10 1
&) Mol 12 13 14 15 16 17 18
& Moz 19 20 21 22 23 24 25
@ Mo 2% 27 28 29 30
= |g, Showroom B
@@ Mot
@ Nos Timers
# Branch B
+ Eranch € Display namme Date Time (24 hour) Operation
Lobbey 4/7/2009 13:43 Computerz
Showroom B 47[2009 18:45 Power ON
No3 47/2009 18:59 Power ON
Shawraom A 4(7/2009 18:59 Power ON

I Enabled Digabled I Add [ Edit[

>
Delete O

Close | |

The details that can be checked and operations that can be carried out at
this time are given below.

1 Projectors

Selects a group or projector to check the status of.

When a group is selected, the timer setting statuses for all projectors
in that group are displayed.
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2 Date Procedures for new timer settings

Shows the current day in a red box.

Days for which timer settings have been made are shown in bold. Procedure

Click 4| or * /| to switch to the calendar for the previous or next

month.
3 Timers

Shows a list of the timer settings.

The line colors in the Timers list have the following meanings: S chechie gods -
L1 Current day's timer setting i oosjoeyia ]
L | When some of the projectors in the group have timer Time (24 hou) [15:04 =

setting enalloleq and others have it disabled for the I o =
current day's timer setting
| | When the current day's timer setting is a disabled setting
B Timer setting for a day other than the current day
4 Delete
B2 Lets you delete timer settings that have been selected oK Cancel
from the timer list.
5 Close

For Operation, you can select operations such as turning the power
on and off and switching the input sources, similar to the control
buttons on the main window. If you set up input source switching,
the projector's power will turn on at the timer start time even if it is
not on at the time. Because of this, it is not necessary to make two
separate timer settings for turning the power on and switching the
7 Add input source.

= Registers new timer settings. @ "Procedures for new

timer settings" p.37

e Closes the Timer Settings window.
6 Edit

Ed Lets you change the timer settings that have been

selected from the timer list. If a group has been selected
for status checking, the settings cannot be changed.

) After completing the timer settings, click "OK".

8 Enabled/disabled The timer settings that have been made will be registered and they
f=%d - Switches the timer settings that have been selected from can be checked in the displayed timer list.
pssted  the timer list between enabled and disabled. NP

;@: You can enable and disable all of the timer settings that have been
registered. Select Timer - Enable or Disable from the Tool menu.
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Mail notification function settings

The mail notification function can be used to send corresponding
notification messages to a preset e-mail address when a projector that is
connected to the network assumes a certain status, or if it experiences a
problem or warning. By using this function, the operator can be notified
of a projector’s status or problems even when the operator is in a
different location from the projectors.

A/
—,@: o Up to three addressees (destinations) can be registered and messages can be
! sent to all of them at once.

e If a critical problem develops with a projector which causes it to suddenly
stop working, it may not be possible for the projector to send a message
notifying an operator of the problem.

o If Standby Mode is set to Communication On (or Network On) or Network
Monitoring is set to On in the projector configuration menus, you can
monitor the projector even when it is in standby mode (when its power is
turned off). @ Projector's User's Guide

e On some projectors, the mail notification function can be set in the
configuration menu. When notification messages are set to be sent in the
projector's configuration menu, both the settings in the configuration menu
and settings made on EasyMP Monitor are functional.

e Detectable status with the mail notification function differs depending on
the projector you are using.

Procedure

Select "Mail notification function" from the Tool menu.

Mail natification function

SMTP server IP address

Sender mail address

Recipient mail address 1

Recipient mail address 2

Recipient mail address 3

@ On £ oif

| Part Humber 25

| Motification event

| Matification event

| notification event

ok Cancel

Make the necessary settings while referring to the table below.

Mail notification

Set to On to use the mail notification function.

function
SMTP server IP Enter the IP address of the SMTP server. Up to
address a maximum of 255 bytes can be entered.

When you change a port number of the SMTP
server, specify this port number. The default
value is "25".

You can enter a valid number from 1 to 65535.

Sender mail
address

Enter the sender's e-mail address. Up to a
maximum of 255 bytes can be entered.

Recipient mail
address 1

Recipient mail
address 2

Recipient mail

address 3

Specify the destination addresses for the
notification e-mail. Up to three destinations
can be set. Up to a maximum of 255 bytes can
be entered.
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Click "Notification event" and check the items for mail
notification in the window that appears.

Set mail notification e pient mail addr

Set notification event

>

Lamp
¥ Replace Lamp
v Lamp failure at power on
¥ Lamp Cover Open

v Lamp Ermar

Air Filker
¥ Clean Air Filter Matice
W Mo ir Filker L3
W Law Air Flow
¥ Replace Air Filker
W 2ir Flow Sensor Er.
IV i filter air flow sensar enar

W Lo air flow error
Metwork.

[ Metwark ermor [TCP connection erar)

[ Metwark emor [ESCAYP.net communication error

™ Metwark ermar [monitor password authentication erar)

|£

(4) click"ok".
“in—

I

The Set mail notification function window appears again.

Repeat Steps 3 and 4 to set the notification events to be notified.

s
K

’ When the setup is complete, click "OK".

—

g,

m—
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E-mail notification

E-mail notification
If the projector experiences a problem or enters a status requiring
attention, an e-mail like that shown below is sent to the address specified
for Recipient mail address.

If there is more than one problem, warning, or status, the corresponding
messages are output to separate lines.

Item Details shown

E-mail subject [Display name displayed in Grouping view or Detail
list view] Projector status notification

Body <Display name displayed in Grouping view or Detail
list view> has entered the following status.

<Warning/error/status message (Please see the
next table)>
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E-mail notification

The details contained in the e-mail message can consist of the following. Message Remedy
Message Remedy Cinema filter warning See your projector User’s Guide
Internal Error See your projector User’s Guide Shutter warning
Fan error Clean Air Filter Notice
Sensor error No signal No image signals are being received

by the projector. Check the

_ connection status and check that the
Lamp failure at power on power for the connected equipment
is turned on.

Lamp Cover Open

Lamp Error’

Supply System Error (Ballast)” Other error Stop using the projector, disconnect

: the power cable from the electrical

High internal temperature error Auto Iris Error outlet, and contact Epson.
Low air flow error Network error (TCP connection Check the following items.
Cinema filter error turned on.

Check that the LAN cable is
Shutter error

connected.
Cooling system error (Peltier Check that Standby Mode is set to
element) Communication On (or Network On)

or Network Monitoring is set to On in

Cooling system error (pump)
Y the projector's configuration menu.

High-temperature warning

@ Projector's User's Guide

Replace Lamp”

- Network error (ESC/VP.net Check that the projector has been
Lamp error communication error) correctly connected to the network.
Lamp failure at power on* - PI’OjeCtOI"S User'S Guide
Supply System Error (Ballast)” Network error (Monitor Password | Check the projector's Monitor
— authentication error) Password.
Replace Air Filter
No Air Filter M

When the projector has 2 lamps, the additional information, such as
Low Air Flow (Lamp 1) or (Ballast 1), is displayed after the message so that you can know
which lamp has problems/warnings.

Air Flow Sensor Err.
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E-mail notification

Messages informing you that the projector has recovered from errors or
warning statuses are sent.
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Application lock function

Application lock function ) The password entry window will be displayed, so enter the

You can use the application lock to prevent third parties from operating ~ setpassword and then click "OK".

thg projectors using EasyMP Monitor and from changing settings If no password has been set (default setting), click OK without en-
without authority. Opening and closing EasyMP Monitor and status tering a password. It is recommended that you enter a password in
monitoring can still be carried out even when the application lock is order to strengthen security.

applied.

The application lock will be cancelled and operations can be carried
In addition, when a password has been set, the password must be entered out as normal.

in order to cancel the application lock. This ensures that the application
lock can not be easily cancelled, and thus improves system security.

Setting a password for cancelling application lock

Switching Application lock between enabled and Carry out the following operations while application lock is cancelled.
disabled

Procedure

Enabling the application lock a,s Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

Procedure
Select "Change the application lock password".

Select "Application lock" from the Tool menu.
Enter the password in both the "New password" and "New

password (confirm)" boxes and then click "OK".

The application lock will be enabled and no operations will be possible

other than opening and closing EasyMP Monitor and disabling the

application lock. The password can be up to 16 bytes in length. Single-byte alphanu-
meric characters can be used.

Disabling the application lock

Procedure

) Select "Application unlock” from the Tool menu.
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Appendix
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Troubleshooting

Troubleshooting

An e-mail message is not sent when a problem occurs
with a projector

Projectors cannot be monitored or controlled

Cause

Remedy

Cause

Remedy

Is the projector connected
to the network correctly?

Check that the network cable has been
connected correctly. If the cable is not
connected correctly, reconnect it.

Is the projector connected
to the network correctly?

Check that the network cable has been
connected correctly. If the cable is not
connected correctly, reconnect it.

Has the projector been set
up correctly for
connection to the
network?

Check the settings for the Network
configuration menu command.

@ Projector's User's Guide

Has the projector been set
up correctly for
connection to the
network?

Check the settings for the Network
configuration menu command.

@ Projector's User's Guide

Has EasyMP Monitor been
installed on the computer
correctly?

Uninstall EasyMP Monitor and then re-install it.
@ p8

Have the SMTP server IP
address, Port Number and
Recipient mail address all
been set correctly?

Check the setting details.

Are all the projectors that
you want to control or
monitor registered?

Register the projectors. @ p.11

Is the projector's Standby
Mode set to
Communication On (or
Network On) or Network
Monitoring setto Oninthe
configuration menu?

In order to use EasyMP Monitor to monitorand
control the projector when it is in standby
mode, the projector's Standby Mode must be
set to Communication On (or Network On) or
Network Monitoring must be set to On in the
configuration menu.

@ Projector's User's Guide

Is the projector's Standby
Mode set to
Communication On (or
Network On) or Network
Monitoring setto Onin the
configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby
mode, the projector's Standby Mode must be
set to Communication On (or Network On) or
Network Monitoring must be set to On in the
configuration menu.

@ Projector's User's Guide

Has a critical problem
developed causing the
projector to momentarily
stop working?

When the projector has momentarily stopped
working, it cannot send e-mail messages. If the
projector cannot be reset even after it has
been checked, contact Epson.

Is power being supplied to
the projector?

Check if the power supply to the location
where the projector is set up has been
interrupted, or if the circuit breaker for the
electrical outlet that the projector is
connected to has been tripped.
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Uninstalling EasyMP Monitor

Uninstalling EasyMP Monitor

The following procedures to uninstall EasyMP Monitor vary depending
on your oprating system.

e If your operating system is Windows 98, Windows Me, Windows 2000,
Windows NT4.0, or Windows XP

Click Start - (Settings) - Control Panel - Add/Remove Programs or
Add or Remove Programs to uninstall EasyMP Monitor. To save or
transfer the existing projector settings, make a copy of the EMP
Monitor.dat file before you uninstall the software. @ "Transferring
the settings" p.7

e When your operating system is Windows Vista or Windows 7

Click Start - Control Panel - Uninstall a program to uninstall EasyMP
Monitor. The settings and logs remain on the hard disk after EasyMP
Monitor is uninstalled. If you do not need this information, delete the
EasyMP Monitor Ver. x.xx (Ver. x.xx represents the version of the
existing software) folder. This folder can be found at "C:\Users\(User
Name)\AppData\Local\VirtualStore\Program Files\EPSON Projector"
if the default settings were used to install the software. To save or
transfer the projector settings, make a copy of the EMP Monitor.dat file
before you delete the folder. @ "Transferring the settings" p.7
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Notices

Notices
Trademarks
- - Microsoft, Windows, Windows NT, Windows Vista, Windows 7, and
Copyright Notice Windows logo are trademarks of Microsoft Corporation in the United

States of America and other countries.

Macintosh is a registered trademark of Apple Computer, Inc.

Pentium is a registered trademark of Intel Corporation.

Epson, EasyMP, and EasyMP.net are registered trademarks and Epson
Exceed Your Vision is a registered logomark of Seiko Epson
Corporation.

Other product names used herein are also for identification purposes

only and may be trademarks of their respective owners. Epson disclaims
Neither Seiko Epson Corporation nor its affiliates shall be liable to the any and all rights in those marks.

purchaser of this product or third parties for damages, losses, costs, or
expenses incurred by the purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, CPD-27792
repairs, or alterations to this product, or (excluding the U.S.) failure to

strictly comply with Seiko Epson Corporation's operating and

maintenance instructions.

All rights reserved. No part of this publication may be reproduced, stored
in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording, or otherwise, without
the prior written permission of Seiko Epson Corporation. No patent
liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the
use of the information contained herein.

© Epson America, Inc. 2009

Seiko Epson Corporation shall not be liable against any damages or
problems arising from the use of any options or any consumable
products other than those designated as Original Epson Products or
Epson Approved Products by Seiko Epson Corporation.

This information is subject to change without notice.
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